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Chapter 1
What is UPStart?

UPStart is a Windows® based software application designed by Powerline
Control Systems (PCS) that provides the ability to easily setup and test your
UPB devices. Using UPStart, you will be able to unlock the hidden
potential inside of your UPB devices to design a custom lighting and
control system that is tailored to your needs and desires.

Not only will you be able to configure your lighting and control system but,
with UPStart’s powerful test capabilities, you will also be able to test your
powerline for noise, measure communication signal strengths, and
functionally test your UPB devices. All this will give you good confidence
that once you are finished installing and configuring your UPB lighting and
control system you will never have to worry about coming back later to fix
or “tweak” the system.

The UPStart tool is designed to interface to the powerline through a special
device called a Powerline Interface Module (PIM). The PIM plugs into any
standard electrical wall outlet and connects to your PC or laptop computer
via either a serial or USB cable.

About this guide
This guide will cover the basic operations of the UPStart tool in both the Online
and Offline modes. Such topics that will be covered are:

The UPStart User’s Guide

Installing the UPStart software and hardware
Creating UPB networks

Adding devices to a UPB network

Deleting devices from a UPB network
Editing device properties

Viewing device properties

Saving designs to file

Restoring designs from file

Programming devices

Comparing device memory to file contents



Chapter 1—What is UPStart?

Quick tour of UPStart
To start the UPStart tool once you have installed it:
1. From the Windows task bar, click the Start button.

2. Choose Programs.
3. Then click PCS Lighting.
4. Then click on UPStart
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Across the top of the UPStart tool you see a standard title and menu bar,
and menus. Across the bottom is a status bar.

Opening and Closing UPStart
When you first start UPStart, its main window appears on the screen.
There are two operations that are important to understand:

Maximize the UPStart Window

The UPStart Window is maximized in the same manner as most Windows
programs. Using the left mouse button, click on the maximum button on
the upper right hand corner of the UPStart window. The UPStart window

expands to fill the whole display.
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Chapter 1—What is UPStart?

Minimize the UPStart Window

The UPStart Window is minimized in the same manner as most Windows
programs. Using the left mouse button, click on the minimize button on the
upper right hand corner of the UPStart window. UPStart is removed from
the display and appears in the Windows Task Bar as a button labeled with
your home design name.

Managing The Views

The UPStart Window can display the module information in two different
views: Icon View or List View. The View can be selected by picking the
View menu bar item.

The Icon View

In the Icon View each module is displayed as a single icon with an icon
label that shows that module’s Room Name, Device Name, and (optionally)
its Unit ID.

The List View

In the List View each module is displayed as a single line on the UPStart
Window. Each line lists all of the information about that module.
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Chapter 1—What is UPStart?

The conventions used in this guide

The following are the common protocols used in this Guide.

Convention Definition

Arial font Text in this font indicates either entries that you type
into UPStart, or responses or messages from the
UPStart system for you to read.

UPStart An abbreviation for the PCS UPB Setup Tool.

In this guide, we assume that you are familiar with the use of Windows, and
the most common Windows conventions, such as click, double-click, right
mouse click, use of the browse function, directories, and files. However,
some of these common Windows conventions most often used in UPStart
are documented in the section following.

For instance, if a procedure says click, we mean to use the mouse button
you most often use, generally the left. If you need to right-click an item,
we’ll specify that.

Procedures and operations common to UPStart

There are several common tasks that occur in multiple places in UPStart,
and that you may find yourself completing in different wizards, or for the
various properties dialog boxes. Rather than repeating them or explaining
them each time they are used, we have placed them here to save your time.

Printing

UPStart provides printing support for details on several elements of your
design, using a typical Windows format. You can select any of the four
print commands available from the File menu:

e  Print—provides the typical Windows print dialog box, allowing you to
determine your print range, number of copies, and so on.

e Pint Preview—shows you a reduced, full page layout of what you are
printing.

e Page Setup—opens a dialog box where you can set the elements you
want to print: home information, floor plans, devices, programs,
groups, schedules, date book, icon gallery, or the house and unit code
inventory.

e  Print Setup—opens a dialog box where you can view and set the name
and location of your printer, paper size and orientation.

4 The UPStart User's Guide
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The UPStart printouts contain information about each element in your
design that you have selected using the Page Setup command. UPStart
formats and prints the information you chose in a vertical list, with headings
for the different sections. The path for your design is included at the top of
each page, along with the printout page number. Because the printouts can
get long, you may want to specify only those elements that you are
interested in seeing each time you print.

Hint: Having a printout of the Network ID and Unit ID inventory is a good
idea as you go throughout your home installing your modules.

Common Windows procedures used in UPStart

There are also typical Windows procedures that are frequently referenced in
UPStart procedures. We have gathered a few of them here, for your
reference in case you are not familiar with them.

Right click for popup menu

Most objects in UPStart have properties attached to them. You can
generally get to the properties for the object by using the mouse, and right
clicking on the object. To do this:

1. Move the mouse pointer to or over the object in question.

2. Click the right mouse button. (Unless you’re using a mouse device set
up for a left-hander, in which case, you would click the left mouse
button.) This is the button that you don’t normally use.

A popup menu appears.

3. With the mouse, move the pointer down the popup menu until you get
to the menu command you want, and click the left (normal) mouse
button.

In the case of properties, the properties dialog box opens.

The UPStart User’s Guide 5






Chapter 2
The UPStart 1.0 Software

Installing UPStart 1.0

If you haven’t yet installed UPStart 1.0 this chapter will guide you through
the steps necessary to do so.

System Requirements

The minimum recommended system requirements needed to run UPStart
properly are:

e Intel Pentium 233 MHz processor (or equivalent AMD™ processor)
e 64 MB RAM (128 MB recommended)

e 10 MB free hard disk space

e Microsoft® Windows® 98, or above

e  One available serial (COMM) port or USB port.

e Powerline Interface Module (PIM) — either Serial or USB

e Serial Cable

Installing The Software

Installing UPStart is similar to installing other Windows® applications.
Before installing UPStart it is recommended that all other applications be
closed.

Step 1: Get The UPStart Installation Software

The latest version of the UPStart Installation Software can be found on the
“Setup Tool Software” section of the Powerline Control Systems website
(www.pcslighting.com). Download the latest version into a convenient
directory of your PC or laptop.

Step 2: Run The UPStart Installation Software

Double-click on the UPStart Installation Software icon to begin executing
it.

The UPStart User’s Guide
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Chapter 2— The UPStart 1.0 Software

Step 3: Follow The On Screen Instructions

The UPStart Installation Software will provide easy to follow instructions to
install UPStart onto your computer.

Connecting UPStart To The Powerline

The UPStart tool is designed to interface to the powerline through a special
device called a Powerline Interface Module (PIM). The PIM plugs into the
powerline at any available 120VAC wall outlet.
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The Powerline Interface Module (PIM)

There are two types of PIMs available: a Serial PIM or a USB PIM. The
Serial PIM connects to any available serial (COMM) port of your
Windows® based personal computer or laptop. The USB PIM connects to
any available USB port of your Windows® based personal computer or
laptop.

UPB Interface Setup Dialog

Once your PIM is properly connected to both the powerline and your
computer it is time to connect the UPStart software to your PIM. This is
done using the UPB Interface Setup Dialog. Selecting the Tools=>UPB
Interface menu item activates the UPB Interface Setup Dialog. Follow the
steps as described below to connect the UPStart software to your PIM.

Did You Know?

The UPB Interface Setup Dialog can be activated by double-clicking on
the online/offline indicator in the lower right of the status bar.

8 The UPStart User's Guide
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Step 1: Specify The UPB Interface And Communications Port

In the UPB Interface Setup dialog specify the type of PIM (Serial or USB)
that you have connected. If you selected a Serial PIM then you must also
specify the communications port (Comm 1, Comm 2, etc.) that you have
connected your Serial PIM to. Note: if you selected a USB PIM then you
can skip this last part.

UPB Interface Setup

Step 2: Test The PIM Communication Path

Press the Test button to test the communication path between UPStart and
the PIM. If the communication path is operational then UPStart will read
the firmware version of your PIM and display it as follows:

UPStart X

(i)

T

Press the “I understand” button to complete the test.

If, however, the communications path is not operational the following error
message will be displayed.

The UPStart User’'s Guide 9



Chapter 2— The UPStart 1.0 Software

10

LIPStart x|

0 Error accessing powerline interface

The powerline interface could not be found on communications port 1.
Check that you hawve the interface powered-up and that the serial cable is
propetly connected between it and the selected cormmunications port then
try this again.

Check that you have the PIM powered-up and that the serial cable is
properly connected between it and the serial communications port, and then
press the “I understand” button and try this step again.

If you continue to have problems communicating with the PIM then contact
PCS Technical Support for help.

Offline Mode:

The UPStart tool can still be used in an “Offline Mode” to setup your UPB
Network devices. Please refer to Chapter 11— “Using UPStart In The
Offline Mode” for more information on using UPStart in the Offline
Mode.

Step 3: Monitor For Powerline Noise At The PIM

UPStart will now automatically start to monitor the powerline for any noise
or signals. The UPB Interface Setup dialog will display the powerline
signal and noise levels on meters. It will also rate the powerline noise as
either none, low, medium, high, or severe.

The UPStart User's Guide
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UPB Interface Setup

’V Powerline Interface Module [FIM] |— |—

Step 4: Close The UPB Interface Setup Dialog

Close the UPB Interface Setup dialog by pressing the OK button or by
pressing the “X” in the upper right hand corner of the dialog.

The UPStart User’'s Guide 11






Chapter 3
Creating A UPB Network

One of the first things you will ever want to do with UPStart is to create a
new UPB Network. In the process of creating a new UPB Network you will
inform UPStart of the Network Parameters that you want assigned to all of
your devices in your installation.

Note: For those familiar with the X-10 protocol, this operation is similar
to selecting a House Code to assign to all of your devices.

What Is A UPB Network?

A UPB Network is simply a set of UPB devices that communicate with
each other on the powerline but don’t communicate with other UPB
devices in neighboring installations (like your neighbor’s house). A UPB
Network is created by assigning the exact same Network Parameter values
to all of the UPB devices on your powerline.

What Are The Network Parameters?

The Network Parameters consist of three individual parameters that are all
assigned the same value in each device of the UPB Network. The three
Network Parameters are:

e The Network ID,
e  The Network Name, and

e  The Network Password.

The Network ID

The Network ID is a unique integer number, between 1 and 250, which
separates your UPB Network from your neighbor’s. The Network 1D that
you choose will be stored inside of each of your UPB devices so that they
will only communicate with themselves and not with your neighbor’s UPB
devices.

Note: For those of you familiar with the X-10® protocol, the Network 1D
acts in a similar fashion to the X-10 House Code.

The UPStart User’s Guide 13
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The Network Name

The Network Name is a 16-character name, stored inside each of your UPB
devices, that identifies your UPB Network in human readable terms. You
can choose anything you want for your Network Name but it is suggested
that you make it something that uniquely identifies the house or
environment that the devices are installed in.

Some examples of Network Names are:
e Ron’s House
e 1515 Main St.

e The Andersons

The Network Password

The Network Password is a 4-digit integer number, stored inside each of
your UPB devices, that gives UPStart permission to write new configuration
data into your UPB devices. The Network Password protects against
unauthorized users changing the internal settings of your UPB devices.

Starting A New UPB Network

14

To start a new UPB Network select the File>New menu item to bring up
the Create Network dialog and follow the steps described below.

Create a new network

Beginning a new design starts with identifying the parameters for your UPE netwark. The netwark nare, id.
and pazzword makes pour UPE network unique. Once these settings are programmed into wour switches and
keypads. this tool can access any of them without manual action on your part. The values vou choose should
be different than the facton defaults which are shown here - 2o pou should change them.

Metwork M ame: IHDH'S House

Mebwark |0 [250

Metwork Pazzword: |4321

Ay time you decide to change these settings you can do 20 using the Nebwork. - Properties menu selection

If you already have switches and keypads installed and the Powerline Interface connected o your computer,
LUPStart can attempt to locate thoze devices and add them to your dezign.

[ After | close this dialog with 0K, start a search for my devices

Ok, I Cancel
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Chapter 3— Creating A UPB Network

Step 1: Select New Network Parameters

In the Create Network dialog select new values for the Network Name, the
Network 1D, and the Network Password. These parameters should be
limited as follows:

e Network Name —a maximum of 16 alphanumeric and punctuation
characters.

e Network ID - and integer value between 1 and 250

e Network Password — four-digit integer between 0000 and 9999.

Step 2: Accept Your Network Parameters

After you have entered the Network Parameters that you want into the
Create Network dialog you can accept them by pressing the OK button.
The UPStart tool will test to see if there are any UPB devices already using
that Network ID before it allows you to use it. If UPStart finds that the
Network 1D that you have chosen is unoccupied it will accept it and close
out the dialog. If UPStart finds that the Network ID you have chosen is
already occupied by other UPB devices it will warn you with the following

message:

& Are you sure?

This Network ID you hawe chosen is already inuse. One or more devices
were discovered that already use this ID. Using this |D may allow your
devices to be unintentionally controlled by vour neighbaor's system

Use this network id anyway?

\ “es. Go ohead | No. Don'tdoit |

At this point you have the option to either force UPStart to accept the
Network 1D you have chosen (in which case you run the risk of having your
devices unintentionally controlled by a neighboring system) or to go back
and select another (unused) Network ID.

Note: The Network Parameters that you select are not programmed into
your UPB devices at this time. When devices are “added” to the network
(see Chapter 4) the chosen Network Parameters are then programmed into
the devices.
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Editing Your Network Parameters

After your Network Parameters have been assigned you can always edit
them later using the Network Properties dialog. To access the Network
Properties dialog select the Network—->Properties menu item.

Metwork Properties

250

This iz the UPE network design for Ron Fienberg's houze.

Note: If you decide to change the Network ID or the Network Password
then UPStart will warn you that all of your devices will require
reprogramming with this new information.

UPStart x|

/1)

16
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Notes and Installer/Customer Information

Note that the Network Properties dialog also allows you to create notes and
save information about the Installer and the Customer. This is completely
optional but it is a good idea to fill in this information to help you remember
things about the network you are configuring.

Metwork Properties

ok | coned |
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Adding Devices

Once you have your UPB Network created it is time to start adding your
UPB devices to that network. As each device is added to the network it will
be assigned the Network Parameters that you have previously chosen. Each
device will also be assigned a unique integer number (called its Unit ID)
along with a human readable Room Name and Device Name so you may
easily identify it in the tool.

Note: For those of you familiar with the X-10 protocol, the Unit ID acts in
a similar fashion to the X-10 Device Code.

UPStart will automatically identify what type of module each of your UPB
devices are and display an appropriate icon or line for each one of them.

e UP St - [Flon's Houss|

Unt 115 Uk 011 U 009 Unet 014 Ura 010 Unt 020 Unat 002
Back Porch Conbioller  Black Posch'w, Downstary Hol'w,., Front Posch Controller  Fiont Poech W, dohony's Bedro, Johrry's Bedio. ¥

3 = o L3 — 1 ﬂ.._'\ 1
is & -,|
= Ml
WE! WS1 WE1 WE | oics (=3 WE1
Uit 013 i [ r

3 Uit 012 Uit D04 Lirsk DOE. Uit 018 Ui M3 Uit D01
Eichen Courd . Kichen Ligh Svslch  Maste Elaitva Mniber Howchis thee ok !

 E

Uret 008 Un
Upatart Hal Upstars Hal'W.

Rinady Sapal i =l File Mocdfind INUM
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Note: This chapter assumes that all of your UPB devices are connected to
the powerline and powered-up and that you have a PIM connected to your
UPStart tool. If this is not the case then you may still add devices to the

UPB Network using the Offline Mode of the UPStart tool. Please refer to
Chapter 11— “Using UPStart In The Offline Mode” for more information

on using UPStart in the Offline Mode.

The Add Devices Wizard

20

Devices are added to the UPB Network using the Add Devices Wizard that
can be activated by either selecting the Device=>Add menu item or by
right-clicking the mouse on an open area to get the pop-up menu and
selecting the New Device item. The Add Devices Wizard will step you
through all of the necessary steps to add one or more devices to the UPB
Network.

Add Devices Wizard Step 1

Thiz wizard takes you through the necessary steps for adding new devices to your UPB network.

Diuring thiz process new information iz programmed inta pour devices, 2o it requires that the new device be
conhected ta the powerling and powered an.

To begin, please select a hew device to be added by putting it into SETUP mode. UPStart then finds that
device. |f you don't know how to put the device into SETUP mode, prezs the Help button.

Help |

Once the device is in SETUP mode, press Mest to continue.

< Bach

Eiriizhy | Cancel |

Step 1: Put The Device To Be Added Into Setup Mode

In order to add a device to the UPB Network, UPStart must first be able to
find that device and communicate with it over the powerline. To do this,
UPStart will search for a single device that is in Setup Mode. Each UPB
device has a method for putting it into the Setup Mode.

How Do | Put My Device Into Setup Mode?

If you don’t know how to put your device into Setup Mode press the Help
button for instructions or consult the documentation for your device. Wall
Switch Dimmers require you to tap the rocker switch 5 times. Pushbutton
Controllers require you to press and hold their top and bottom buttons.
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After the device is in the Setup Mode press the Next button to begin the
adding operation.

Warning: devices will automatically time-out of the Setup Mode after five
(5) minutes. Make sure that you don’t wait too long to press the Next
button after you have put your device in Setup Mode or you may have to
repeat some of the steps.

UPStart will begin performing the command steps necessary to find and
read your device’s memory.

Operation | Rety | Data | -]
J Read room name MHew Room Mame

J Read device name Mew PCS w510

J Read configuration 1 01 64 FF 02 00 FF 03 50 FF 04 3C FF 05 28 FF 06
J Read configuration 2 14 FF FF 64 FF FF 00 FF FF 50 FF FF 3C FF FF 28
J Read configuration 3 FF FF 14 FF FF 64 FF FF 64 FF FF 64 FF FF 64 FF
J Read configuration 4 FF FF FF FF FF FF FF FF FF FF 64 FF 64 00 00 FF
J Read configuration 5 00 00 FF FF FF FF FF FF FF FF FF 84 FF 83 84 FF
J Read configuration & 2200FF 22 64 FF 2300 FF 2364 FF 24 FF FF 21
J Read configuration 7 FFFF20FF FF 2200002264 00220001 22 64
J Read configuration 01 2600 00 26 &4 00 25 1E FF FF FF FF FF FF FF
J alidate configuration 0k

This operation completed successfully, Press OF to continue.

Try again |

Details |

If UPStart fails one of these command steps it will place a red “X” next to
the failed step and it will stop and instruct you as to what to do next. If it
successfully completes all of its command steps UPStart will place a blue
checkmark next to each step and display a message that the operation

completed successfully. Press the OK button to continue to the next step.

Note: by default, the command steps dialog will stop and wait for you to
press the OK button before going on to the next step of the wizard. If you
would rather not be bothered with this each time the command steps are
done then you may configure UPStart to not require the OK button press.

Refer to Chapter 12 — “Customizing UPStart Behaviors” to learn about
changing the UPStart options.
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Step 2: Select A Room Name, Device Name, And Unit ID

Now that UPStart has successfully found your device it is time to give it a
name and other identifying information. Enter a 16-character (maximum)
Room Name and a 16-character (maximum) Device Name that will be used
to identify your device. It is suggested that you make the names as
meaningful to you as possible to help you distinguish one device from
another.

Some examples of Room Names and Device Names are:
e Living room - Light By TV
e Ron’s Office — Scene Controller
e Master Bedroom — Wall Switch

Also enter an integer Unit ID for your device. The Unit ID may range
between 1 and 250 and must be unique for each device in your network.
UPStart will place a suggested Unit ID to use in the dialog. You may

choose to use it or you may select another one of your choosing as long as it

is not assigned to another device already.

Add Devices Wizard Step 2

LIPStart has successfully found vour new II'W51 ]l Switch - 1 Channel

Select a room narme and device name from anes you have previously used or bype in new anes. [n the

next step UPStart updates the device with the names selected here.

Hint: Choose names that help pou identify it. For example: Living Roonn - Light by T, or
Fion's Office - Scene Contraller

Room Mame Device Marne nit 1d
IMaster Bedioom j IW’aII Switch j I'I ﬂ

[™ Eraze existing configuration

< Back I » MNest I Firmsh | Cancel |

Note: many devices come with factory default configuration information
stored in them that may save you some time in setting up your device. If
you would rather start with a completely un-configured (blank) device
then you should check the checkbox labeled “Erase existing
configuration” prior to pressing the “Next” button.
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Once you have entered the identifying information that you want assigned
to your device press the Next button to begin programming it into your
device. UPStart will begin performing the command steps necessary to
write the identifying information along with the Network Parameters into

your device.
Command Steps
Operation | Fietry | Data | -
/ Check UPE version oot
J Check device tipe [wST]Wall Switch - 1 Channel
J wiite UPE 1d F&0143210001000100071 0414 00000000
J Yerify UPE 1d Fa 01 432100010001 0007 041400000000
J wiribe network name ok
J ‘erify netwark name Ok
J Wiribe raom narie 0k
J “Werify room name Ok
J ‘wiite device name Ok
J Werify device name ok
J Exit setup mode Ok
Thiz operation completed successfully. Press OK to continue.

Try again

Dietails |

If UPStart fails one of these steps it will place a red “X” next to the failed
step and UPStart will stop and instruct you as to what to do next. If UPStart
successfully completes all of its command steps it will place a blue
checkmark next to each step and display a message that the operation
completed successfully. Press the OK button to continue to the next step.

Note: by default, the command steps dialog will stop and wait for you to
press the OK button before going on to the next step of the wizard. If you
would rather not be bothered with this each time the command steps are
done then you may configure UPStart to not require the OK button press.

Refer to Chapter 12 — “Customizing UPStart Behaviors” to learn about
changing the UPStart options.

Step 3: Finish Or Add Another Device

If you have more devices to add then press the Next button and repeat steps
1 through 3. If, however, you are finished adding all of your devices press
the Finish button.
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Add Devices Wizard Step 3

Your devices are now added to your UPB network database. They have all
been assigned the same Network Parameters, a unique Unit ID, and your
specified Room Name and Device Name identifiers. An icon has been
created and displayed for each one of the devices you have added.

Deleting Devices

After a device has been added to your network database, it can be deleted at
any time by following the steps outlined below.

Deleting Procedure
Step 1: Select The Device To Be Deleted

Highlight the icon for the device that you want to have deleted from your
UPB Network.
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Step 2: Request That UPStart Delete This Device

Select the Device—>Delete menu item or right-click the mouse to get the
menu pop-up and select the Delete item. UPStart will display the following
message to confirm that you are sure you want to delete this device.

UPStart x|

& Are you sure you want 1o delete Unit 015 - Back Forch - Cantraller 7

Deleting a device atternpts to reprogram itto change its network id to
zero. This makes the device unavailable but retains all existing

canfiguration in case you want to add it back toyour network later.

“es. Go ahead { No.Don'tdoit

Step 3: Confirm The Deletion

If you are sure you want to delete the selected device from your UPB
Network then press the “Yes. Go ahead” button.

UPStart will attempt to communicate with the device and set its Network 1D
to 0 to effectively delete it out of your network. If you have already
removed the device from the powerline or the device is defective the
following message may appear.

UPStart

@ It may be helpful to know...

There was a problem attempting to program the device. This could have
failed hecause the device had already been uninstalled or is not

operational. twill be removed from the file amaway.

The device will be deleted from the network database file anyways. Press
the “I understand” button after reading the message.

After the device is deleted, all of its information is removed from the
network database and the icon for the device is no longer displayed.
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Saving Your Network Database To File

It is always a good idea to save your UPB Network information into a file
that can be retrieved and modified later. This can be useful for such things
as:

e  Saving a network design so it can be restored later
e Saving a network design so it can be duplicated in multiple homes

e  Saving a network design so it can be modified offline

Saving The Database For The First Time

Select the File->Save As menu item and select a directory and filename to
save your network database to. Press the Save button to store your network
database to the specified file.

o R ~lalx
= | &
= = !
oica W | Wl | oica . WE1 Wl WE1
Unk 015 Ura 011 ni (0 Ui 014 it 0 Uit (G0 e 002 unie () Ui 005
Bk Posch Cimtber  Back Peach W, Duwnstaes Kl Fieed FuchContsobe  Froed Ponch W Juobvey's B chery/s B Kann'e Bnchoom W, K Bathvoces W
% W ¥ % — ) = &
O 0 | eoe——— (2 [
W1 W51 e =1 [0 e ]| rﬁﬂ DTis WE1
U 013 Ve 012 [T - . Uit 016 U 017
KichenCount Kihen Light Sech  Mases gt |51 "ok = 'wb W OfceConholer  Ofice Light Swetch
WE WE1
Ui (08 U 00
Ipniars Hall [ Fmpuim [Hors Hourd gt S
L (e = Cancel |
| [ A A S EOND > Lo : S e
| Zlkn Dot | ) By (€1 [fareiaiian - 0. 0Pt | i Mot Vil | PUMPLARIOE . | Gkt | =5

The UPStart User’s Guide 26



Chapter 5— Saving Your Network Database To File

Periodic File Updates

Each time new configuration data are programmed into your devices,
UPStart will automatically write those changes into your file. You can also
write the current set of configuration data into your file using the
File->Save menu item.

Note: Each time UPStart writes to a device’s memory it will write the
most recent set of changes that have been specified. These changes may
not yet be stored in the design file.

By enabling the “Auto Save On Device Write” option, UPStart will write
the latest configuration information into the design file each time that it
writes this information to the device. This helps ensure that your file
matches your hardware.

Refer to Chapter 12 — “Customizing UPStart Behaviors” for instructions
on configuring the UPStart options.

Opening A Saved Network Database

You can have UPStart open any one of your previously saved network
database files for viewing or editing. This section will describe the steps
necessary to do this.

Opening A Saved Network Database File

Select the File>Open menu item and browse and select a previously saved
network database file. Press the Open button to open the specified network
database file.
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Automatic Network Verification

Once the network database is opened, UPStart will automatically attempt a
Network Verification operation to check that the contents of the file still
match the contents of all of the UPB devices” memory. The Network
Verification operation attempts to find every device in your UPB Network
and verify that its configuration memory matches what is in the network
database file. Refer to Chapter 9 — “Verifying Your Devices” for detailed
information on running a Network Verification Test on your network.

Note: If you don’t want UPStart to automatically perform this Network
Verification each time a file is opened, be aware that it can be disabled.

Refer to Chapter 12 — “Customizing UPStart Behaviors” for instructions
on configuring the UPStart options.
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Exporting The Network Database

The network database contains all of the information that is programmed
inside of your devices. This information is useful to many home

automation controllers to allow them to know how

your network is setup.

UPStart offers a Network Database Export feature that creates an export file
of your network database in a format that can be imported into many home
automation controllers. Refer to the UPStart Export File Description

Document for details on the format of the export fi

To export your network database simply select the

le.

File=>Export menu item

and choose the directory and filename that you want.

Select export file

Save in: I @ Desktop

EEE

My Computer
My Documents
E Wetwork Meighborhood
Online Services
Test Files

File name: ILSTTest.upe Save

Save as type: IUPB Export Files [* upe]

-

Cancel

[ see |
EEEN

4

When you press the Save button UPStart will create an Export file of your

network database and store it in the specified file.
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Editing A Device’s Configuration Info

This chapter explains the general editing procedure for a UPB device’s
configuration information. It will not go into detail as to what configuration
information each device has available nor how to use it. For this type of
information please consult the User’s Guide for the individual device you
are interested in. You may also want to consult the UPB Lighting System
User’s Guide for explanations on how to edit device configuration
information to create lighting systems.

The general procedure for editing a device’s configuration information is as
follows:

1) Open up its Edit Device Dialog
2) Make any desired changes in the dialog

3) Program the changes into the Device

Opening Up The Edit Device Dialog
The Edit Device Dialog can be opened up in several different ways; either:
e Double-click on a device’s icon, or
e Right-click on a device’s icon and select the Edit pop-up menu item, or

e Select adevice’s icon and then pick the Device—> Edit menu item.

About The Edit Device Dialog

The Edit Device Dialog (see figure below) is a multi-tabbed dialog that
allows you to both view and edit the contents of the device’s configuration
memory.
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Edit Device: Unit 001 - Den - Lights
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Most tabs on the Edit Device Dialog have a “Read” button that allows you
to read in the most current contents of the device. Most tabs also have a
“Program Device” button that allows you to program the contents of the
dialog into your device.

Making The Desired Changes

Navigate through the tabs and make any changes that you desire. When
you are satisfied with these changes then go on to the next step and program
them into your device.
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Saving The Changes For Later

You may also decide to just save these changes and program them into your
device at a later time. To do this, press the OK button and the Edit Device
Dialog will close and its contents will be saved into the file.

Canceling The Changes

You may also decide to cancel the latest changes that you have made to the
Edit Device Dialog. To do this, press the Cancel button and the Edit Device
Dialog will close and the changes will be ignored.

Programming The Changes Into The Device

Once you have made your desired changes to the Edit Device Dialog you
can immediately program those changes into the device.

Note: You do not have to program the changes into the device at this time.
If you would rather save up the changes and program the device later
simply press the OK button to accept the changes and close the Edit
Device dialog.

Refer to Chapter 7 — “Programming Your Devices” for instructions on
programming your devices with saved up changes.

To program the changes you have made into your device press the
“Program Device” button. UPStart will figure out what changes need to be
made and it will write them into your device’s configuration memory. As it
goes through the steps to write the new configuration information, UPStart
will display the command steps as shown below.
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Command Steps

J Wiite configuration 4
J Werify configuration 4
J Write configuration 5
J Yerify configuration 5
J Wiite configuration &
J Yerify configuration B
J Wiite configuration 7
J Werify configuration 7
J Wiite configuration 2
J Werify configuration 8
J E it wirite: made

When the programming operation is complete, press the OK button to
return to the Edit Device Dialog.

When you are through with the Edit Device Dialog press the OK button to
close it.

34

The UPStart User’'s Guide



Chapter 7
Programming Your Devices

At some point in time you might want to program a device with all of the
saved-up changes that are stored in the network database file. This can be
for any of a number of reasons:

e You might have made changes offline and now you are online, or
e You might want to restore and older configuration of the device, or

e You might have made changes to the file that you weren’t sure about at
the time but now you are ready to put them into the device.

In any event, UPStart will mark the device(s) that have “saved-up”
modifications that haven’t been programmed into them yet with a red bar
below their icons. This chapter will tell you how to use UPStart to program
those changes into your device.
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Programming The Configuration Information Into A Device

To program a single device with the configuration information saved in
your network database, simply follow the steps below.
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Step 1: Select The Device To Be Programmed

Using your mouse click on and select the icon of the device to be
programmed. Then start the Programming operation by right clicking on
that icon and selecting the Program pop-up menu item. Alternately, you
can start the Programming operation by selecting the Device>Program
menu item. UPStart will warn you that you will be overwriting the device
memory.

UPStart

& Are you sure?

A change was made to the configuration settings for this device, saved in
the network file, but not yetwritten ta the memory of the dewice. If yvou

continue this operation you may be overwriting changes that were made
to the dewvice memory at a previous time and not sawved in the netwark file

To see howthe dewvice memary differs from the network file configuration
settings. select from the menu: Network then Verify, or selectthe device,
right click. and choose Yerity from the popup menu

Toignore whatis in the device memaory and to update itto what is
specified in the netwark file, selectthe device. right click. and choose
Pragram from the popup menu.

Continue this operation even though the device has not been verified?

VE—— | ey

Step 2: Start The Device Programming

Press the “Yes. Go ahead” button to begin the Programming operation.
UPStart will figure out what changes need to be made and it will write them
into your device’s configuration memory. As it goes through the steps to
write the new configuration information, UPStart will display the command
steps as shown below.
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Operation | Fiety | Data | -
J “wiite configuration 4 akK

J erify configuration 4 ok

J ‘Wwiite configuration 5 04

J Werify configuration 5 04

J “wiite configuration & akK

J ‘Werify configuration B ak

J ‘Wwiite configuration 7 ak

J Werify configuration 7 ak

J Wiite configuration 8 akK

J Werify configuration 8 ak

J Exit write mode ak |
This operation completed successfully. Press OF. to continue.

Dretails | Try again

When the programming operation is complete, press the OK button to close
the dialog. The device’s icon should now have a blue bar underneath it
indicating that the contents of the file match the contents of the device’s
configuration memory.

Note: by default, the command steps dialog will stop and wait for you to
press the OK button before going on to the next step of the wizard. If you
would rather not be bothered with this each time the command steps are
done then you may configure UPStart to not require the OK button press.

Refer to Chapter 12 — “Customizing UPStart Behaviors” to learn about
changing the UPStart options.

Programming The Configuration Information Into All Devices

To program all of your UPB devices with the configuration information
saved in your network database, simply follow the steps below.

Step 1: Select The Program All Operation

Select the Network->Program All menu item. UPStart will warn you that
all of your network devices will be overwritten with the current network
database information.
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UPStart

(2)

[ e Goin | [Tmpandsi

Step 2: Start The Program All Operation

Start the “Program All” operation by pressing the “Yes. Go ahead” button.
UPStart will automatically attempt to program the latest set of network
database modifications into your devices.

Multi-Device Operation

W Testfor the PIM
J Test for noize at PIM

J Test noize level at device
= Test signal level at PIM
Test signal level at device

Fead netwark 1D
Read unit D

Press the OK button when the programming is complete.
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Performing A Device Communications Test

After a device is added to your network it is a good idea to test its
communication to see how strong its signals are and how heavy the
powerline noise is near it. UPStart gives you an easy way to do this.

The Communications Test Tab

The Edit Device Dialog has a special tab labeled Communications Test that
allows you to run a UPB communications test between the selected device
and the PIM. The Communications Test will transmit a long UPB message
from the PIM to the device and then it will receive a long UPB message
from the device to the PIM.

Edit Device: Unit 003 - Front Hall - Controller
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Running The Communications Test

Press the “Run Communications Test” button to start the test. Note that you
can also specify to run the test more than once by increasing the Number of
Samples. During this two-way communication test, UPStart will measure
and display the signal and noise levels that occur at both the device and at
the PIM. It displays these four values on four meters and it also displays
some other useful information.

Rating The Communications Test

Besides the four meters, UPStart also displays ratings for the Signal Levels
and Noise Levels. Table 1 shows the possible ratings for the Signal Level.
Table 2 shows the possible ratings for the Noise Level.

Signal Level Meaning

Excellent UPB signals are very strong! Perfect for good powerline
communication.

Good UPB signals are still strong enough for good powerline
communication but severe noise may cause problems.

Low UPB signals are weak but still good enough for
powerline communication where noise is not a problem.

Very Low UPB signals are very weak but still good enough for
powerline communication where there isn’t noise.

No Signal No signal was detected on the powerline. Something is
wrong with the powerline communication.

Table 1: Signal Level Ratings

Noise Level Meaning
None Powerline noise is non-existent.
Low Some powerline noise but not enough to affect

powerline communications.

Medium Some powerline noise high enough to possibly affect
powerline communications.

Severe Powerline noise is too high to communicate reliably.

Table 2: Noise Level Ratings
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Communication Phase

The Communications Test results will also display the relative Phase (Same
or Opposite) between the Device and the PIM.

What Does Phase Mean?

Residential electrical wiring in the U.S. is configured as 240 VAC that is
split into two separate phases of 120 VAC. If the Device is on the
opposite phase as the PIM then the UPB signals have to travel through the
power transformer and they tend to be weaker then when the Device is on
the same phase as the PIM. This can sometimes help you solve poor
communication problems (see the UPB Communication Troubleshooting
Guide).

Functionally Testing Your UPB Device

After a device is added to your network it is a good idea to test its
functional operation to see that it controls its outputs and detects its inputs
properly. UPStart gives you an easy way to do this.

The Device Test Tab

The Edit Device Dialog has a special tab labeled Device Test that allows
you to run a functional test on the selected device. The Device Test tab will
look different for each type of device you are testing. This chapter will
discuss the Device Test tabs for the Wall Switch Dimmer and for the 6-
Button Controller.

Testing a Wall Switch Dimmer

The Device Test tab for a Wall Switch Dimmer is shown below. From this
tab you can test that your Wall Switch Dimmer properly turns on to any
level at any of 16 fade rates. You can also test that the module can be set to
blink its load at any of 16 blink rates.
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Edit Device: Unit 001 - Den - Lights

[Enty [Rovd [Cnd [ Comporent  [Dest [Component [ [

If your Wall Switch Dimmer has been configured to transmit you can also
capture any of its transmissions in the Reception Log to verify that they are
working properly.

Testing a 6-Button Controller

The Device Test tab for a 6-Button Controller is shown below. From this
tab you can test that your 6-Button Controller’s LEDs properly turn on and
off upon command. You can also press the pushbuttons on your 6-Button
Controller and capture any of its transmissions in the Reception Log to
verify that they are working properly.

Edit Device: Unit 006 - Back Hall - Controller

[ ] [ oai |
[ ] [ oai ]

[Enoy [Revd [Cmd  [Comporert  [Dest [Comporet [we [
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The Network Communications Test

The Network Communications Test is a special test of the two-way
powerline communications between UPStart and the devices in your
network. This test can be set up to run for any length of time and does not
require user intervention. During this test, powerline messages are
periodically transferred between the PIM and the network’s devices and the
resulting signal strengths and noise levels are measured and recorded both
at the PIM and at the device. This test is a great way of finding problem
areas in your powerline network and correcting them before they become an
issue. This chapter explains how to setup, start, stop, and interpret the
results of the Network Communications Test.

Setting Up The Network Communications Test

The Network Communications Test is set up and run using the Network
Communications Test Dialog. This dialog is activated by selecting the
Network—>Comm Test menu item.

Hetwork Communications Test %]

1D | Room | Name [ Phase | Run | Test| Signal@PIM | Moise®PIM | Signali®Dev | Noie@Dev | DMoi. | DMoi. DNo

0| | ol

[n] | Room | Marme | Phasel Tatal Comrect | Tatal Failure | Avg Signal@PIM ‘ Moize CHaPIM ‘ Awg Noize@PIM ‘ Awg Sigr

« | 0|

Every |15 _I:j minutes test each device |10 _I:j times until the test has been repeated ISE _I:j times ™ Test only the selected devices

Clase

The Network Communications Test Dialog provides selectors for setting up
the following test parameters:

e Number of minutes between each test

e Number of times to communicate with each device per test
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e Number of times to perform the test

Select the test parameters that you desire. For example: Run the test every
15™ minute communicating 4 times with each device and continue until 96
tests have been performed.

Starting The Network Communication Test

44

Start the Network Communication Test by pressing the “Run
Communications Test” button. UPStart will bring up a dialog that
(optionally) allows you to save the test results to a log file.

Select file for communications test summary ﬂ

Save in: I@LUQS j gl

est_031120165615.txt
MetCommTest_03112408431 3 k=t
MetCommT est_031124084350. kst

MetCommT est]_040114115229 tat
MetCommT estl_04011 4152408 tat
MetCommTest 031124084517 tat MetCommT est]_040114153424 tat
MetCommTest_031124084E607 tat MetCommT est1_0401 26115352 kst
""" MetCommTest_021124084707 tut MetCommT est]_04021 7162332t
4| | i

File name: INetEommTest1_D4D3DS1 22116 bt Save I
Save as type: |T><T file:g [* k2t j Cancel |

If you do not want to create a log file then press the “Cancel” button. If you
do want to create a log file of the Network Communications Test then select
the directory and filename that you desire and press the “Save” button. The
Network Communication Test will start immediately.

|

Metwork Communications Test
10| Room | Hame [ Phase | Run | Test | Signal@FIM | Noise@FIM_ | Signal@Dev | Noise@Dev | DNoi. | DNoi. | DLl
002 Den Lights k3 2 4 41 o/0/0 55 1} 1} 0 1}
003 Kitchen Appliances k3 2 4 40 o/0/0 56 1} 1} 0 1}
004 Kitchen Lights k3 2 4 39 o/0/0 &7 1} 1} 0 1}
005 Outside Lights s 2 4 41 o/0/0 &7 1} 1} 0 1}
006 Back Hall Controller s 2 4 40 o/0/0 44 1} 1} 0 1}
007 Master Bedroom  Lights s 2 4 40 o/0/0 54 1} 1} 0 1}
008 Front Hall Chandelier 5 2 4 40 o/0/0 53 1} 1} 0 1}
009 Entertainment Lights 5 2 4 40 o/0/0 50 1} 1} 0 1}
010 Master Bedioom  Controller H 2 4 42 0/0/0 47 0 0 0 0
001 Front Hall Contraller H 2 5 40 0/0/0 Ll 0 0 0 0 =
002  Den Lights H 2 5 4 o/s0/0 52 1} 1} 0 o

i | o

Reading signal lewvel from PIM. Attempt 1

1D Aoom | Name [ Phase | TotalCarect | Total Failure | Ava Signal@FIM | Noise CI@PIM [ Avg Naise@PIM || Awa Siar
001 Front Hall Controller 5 0010 0000 o041 0onoa 0000 o040
002 Den Lights E oo1a 000d 0040 00000 000d 0056
003 Kitchen Applisnces s oo1a 000d 0040 00000 000d 0056
004 Kitchen Lights E oo1a 000d 0040 00000 000d 0055
005 Outside Lights S oo1a 000d 0040 00000 000d 0057
006 Back Hall Controller S ooo 0ooo0 0040 ooonoo 0ooo0 o4
007 Master Bedio...  Lights S ooo 0ooo0 0040 ooonoo 0ooo0 0055
008 Front Hal Chandelier = ooo 0ooo0 0040 ooonoo 0ooo0 0056
009 Entertainment  Lights 3 ag1g oog o039 noooon oog Q05&
010 Master Bedro...  Contraller B oo1o oooo oo40 ooooo oooo 004

o o0 0ooo0

| | |
Every |15 _I;l mitutes test sach device |10 _I:j times until the test has been repeated |36 _I? times ™ Test anly the selected dsvices

Stop Close
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UPStart will begin running the Network Communications Test. As each
device is tested a line is created in the upper pane of the dialog. After all of
the devices have been tested the lower pane of the dialog is updated with
results.

Note: UPStart will continue to wait the specified amount of time between
tests and then perform the next set of tests at the programmed time. This

will continue until the specified number of tests is completed or you press
the “Stop” button. You can still use UPStart for other purposes while it is
waiting for the next run to begin.

Interpreting The Network Communication Test Results

The Network Communications Test provides very important and useful
information about the integrity of your UPB network communications.

The results of this test are usually saved into a log file for later review and
interpretation. Interpreting the results of the Network Communications Test
is out of the scope of this guide. Please refer to the Technical Brief:
Running The Network Communications Test for an explanation of the test
results.
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Performing A Network Verification

The Network Verification Test verifies that every device in the network is
still communicating properly and is still configured with the same
information contained in the network design file.

Whenever a saved network database is first opened, UPStart will
automatically attempt a Network Verification operation. You can also
perform a Network Verification operation at any time by selecting the
Network->Verify menu item.

Why Perform Network Verification?

In a system in which configuration information is stored in two different
places (in your devices’ memory and in your network file) it is important
that the two copies of information sync up. Confusion can occur when the
file information is different from the device information. UPStart tries to
warn you whenever it thinks the two copies are mismatched. It is always
left up to you to decide whether you want to overwrite your file with the
device’s configuration information or if you would rather program the
devices with your file’s configuration information or whether you wish to
leave them mismatched.
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The Network Verification Dialog

The Network Verification Dialog runs the Network Verification Test.

Vearify
For each device in pour design file, UPStart verifies that the configuration information in the device memaony matches the settings
saved in this netwaork design file. \While this process is taking place, UPStart also checks how well it is communicating
with the device. All this information iz displaped below. Refer to the legend ta interpret the results,
¥ Veiity device canfiguration info

oo EEEEE EEEED 0000000000 | 1o
e OO0 JOO00 0000000000 | Fuee
w00 I 0000 00000 0000000000 || e
est-oe0 (OO0 O OO0 00000 OO0 00 W vi=ins
w0 0000 00000 0000000000 | [Jue
o1z OO0 DO 00 OO0 0 O OCC0
e OOO00 00000 00000 0Odod Mvormovos
s (OO0 OO0 00 00000 OO0000 L comm pect
S N A comm v
-2 OO0 OO0 00 00000 0O0Od Ao
=20 0000 0000000000 00000 || pr v
=122 (AO00 00000 O0OOO00 dodod P tajer ai
=120 JOO00 OOO00 7 inn i

V New

Cloze |

Figure 1: The Network Verify Dialog

The Network Verification Dialog (Figure 1) presents a colored box that
represents each possible device in your selected network. There is a box for
each of the 250 possible Unit IDs. A checkbox is provided to allow you the
option to either have UPStart verify all of the configuration information or
to just verify that the specified device(s) exists.

Finding All Devices In Your Network

48

The first thing UPStart will do in the Network Verification is to attempt to
find all of the devices that exist on your specified network. This process is
called Device Enumeration. As one of your devices is found, its
corresponding box will turn green. If your device cannot be found then its
box will turn black. If a new device (that is not in your network database
file) is found then its box will turn yellow (see the legend in Figure 1). The
Device Enumeration will repeat until it gets two passes with the same
information.
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Note: in certain very noisy situations the Device Enumeration operation
may not be able to accurately determine which devices are on your
network. UPStart will make numerous attempts and then inform you if it
was unsuccessful. It is best not to try to configure any devices until the
cause of the high powerline noise is resolved. Refer to the UPB
Communication Troubleshooting Guide for possible ways to troubleshoot
bad communication and noise problems.

Testing The Communication Level

UPStart will then attempt to communicate with each of the devices it has
found and change the lower triangular portion of its box to a different color
based on how strong the UPB communication signal is. The color of blue
represents good communication, orange represents poor communication,
red represents bad communication, and black represents no communication
(see the legend in Figure 1).

What If The Communication Is Bad?

If any device is found to have bad (or failed) communication it is best not to
try to configure this device until the cause of the bad communication is
resolved. Refer to the UPB Communication Troubleshooting Guide for
possible ways to troubleshoot bad communication and noise problems.

Comparing The Device Memory To The File Contents

Next, UPStart will check if the contents of the devices’ configuration
memory match the contents of the file. As each device is checked, UPStart
will change the upper triangular portion of its box to a different color based
on how well the device memory matched the file contents. The color of
blue represents perfectly matched configuration data, orange represents
minor differences were found, red represents major differences were found,
and yellow represents a brand new device was found (see the legend in
Figure 1).

What If Device Memory Matches The File Contents?

An upper triangle that is blue means that the device’s configuration memory
matches the file’s configuration information exactly. If the contents of all
of your devices’ configuration memory match the contents of the file, you
are now ready to proceed with using this file to configure your devices. Just
press the Close button and continue using UPStart to configure your
devices.
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What If Device Memory Is Different Than File Contents?

An upper triangle that is other than blue means that the device’s
configuration memory differs from the file’s configuration information.

If this is the case, there are three ways to proceed:
1) Ignore the differences for now
2) Overwrite the file with the contents of the device memory
3) Program the device memory with the contents of the file

UPStart will inform you that you can always examine the differences to
help you decide which way you would like to precede.
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After reading this message press the “I understand” button.

Examining The Differences

To examine the differences between your file and your device simply
double-click on the square that corresponds to the non-verified device.
UPStart will then proceed to read the entire contents of that device’s
configuration memory. The command steps for this read will be displayed.
Press the OK button after it is finished.

Operation | Rietry | Data | B
J Fead network, name EHx
J Fead room name Front Hall
J Fead device name Controller
/ Fead canfiguration 1 FF FF FF FF 05 06 00 00 01 66 88 66 FF 02 55 77
/ Read canfiguration 2 55 FF 03 BE B6 66 FF 04 B6 66 66 FF 05 BE BE 66
J Read configuration 3 FF O BE BE 66 FF 00 FF FF 33 44 00 FF FF 22 44
/ Read canfiguration 4 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
/ Read canfiguration 5 FF FF FF FF FF FF FF FF FF FF FF FF FF 3F 84 7F
J Read configuration B 2200FF 2264 FF 2300052364 05 24 FFFF 21
/ Read canfiguration 7 FF FF 20 FF FF 22 0000 22 64 00 22 00 01 22 64
/ Read canfiguration 01 22 0008 22 64 08 25 1E FF 00 00 00 FF FF FF
Thiz operation completed successfully. Press OF to continue.
Dretailz | Ty again

The Verify Details Dialog will then be presented to you allowing you to see
what information did not match between the file and the device. This might
help you decide whether you would like to keep the file copy or the device
copy of the configuration information.

Use the scroll bar to help you determine what are the differences. Items that
are different between the file copy and the device copy are displayed in red.

The UPStart User’s Guide 51



Chapter 9—Verifying Your Devices

Type I[WMCB] 'l Maunt Contraller - 6 Buttan Winar diff
Room MName IFront Hall E
Device Mame ICUHUDHBI Comm good

The device memony is shown below, Any differences are shown in red,
The first line displaps the device memary recorded in this file.
The zecond line displayz the memory read from the device.

Itemm | 5| Noise.. | 5[ N.| NID] UID | Pewd | Options | Version | MID
FILE COFPY 123 003 1234 000 oo oo
MOTVERIFIED 23 0/0/0 44 0 123 00F 1234 000 a0 0001
N 2l

When you are done viewing the Verify Details Dialog press the OK button
to close it.

You can repeat this examination on any other devices that do not match the
file. Once you are through examining the differences close the Network
Verification Dialog by pressing the Close button.

What Are Those Colored Bars Under Each Icon?

UPStart places a colored bar under each icon to indicate the current
verification state of each device in your network. The meaning of each
colored bar is defined as follows:

Blue = The Device and File Match
None = The Device and File Do Not Match
Red = The File was Modified from the Device

Examining The Differences Again

52

You can always view the differences between an unverified device’s
configuration memory and its file by selecting the device’s icon and then
choosing the Device> Verify menu item. UPStart will perform the same
examining process as described in “Examining The Differences” above.
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Resolving The Differences
Now that you have examined all of the differences between your devices’
configuration memory and the network database file it is time to resolve
those differences in any of three ways:

1) Ignore the differences for now
2) Overwrite the file with the contents of the device

3) Program the device with the contents of the file

Ignoring The Differences
If you choose to ignore the differences for now UPStart will simply mark
each device that is unverified with a red bar (or no bar) beneath its icon.
Keep in mind that from this point on UPStart will display what is in the
network database for the unverified device but it does not know (for sure)

what is inside the device memory.

Overwriting The File With The Device Contents

If you have decided that you want to overwrite the file copy of a device’s
configuration information with whatever is inside of the device’s memory
then follow the steps outlined in Chapter 10 — “Reading Devices Into The

Network Database”.

Overwriting The Device Contents With The File

If you have decided that you want to overwrite the device memory with the
file copy of a device’s configuration information then follow the steps
outlined in Chapter 7 — “Programming The Configuration Information Into

All Devices”.
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Discovering Devices

At some point in time you might want to discover all of the devices that are
on your selected network. This can be for any of a number of reasons:

e You might want to know if any unexpected devices are on your
network, or

e You might want to create a brand new database file based on the
configuration information in your devices, or

e You might want to make sure all of your devices are still responding.

UPStart is capable of quickly polling the network to see which devices exist
on your network. It also has the option of adding the devices it discovers to
the network database (if they are not already there). This chapter tells you
how to use UPStart to do all of this.

Discovering Existing Devices

To discover which devices exist on your specified network follow the steps
below. Use this method if you want to verify that all of your devices are
still present or if you want to make sure no one added new modules to your
network.

Step 1: Bring-Up The Discover Dialog

The Discover Dialog is activated by selecting the Network-> Discover
Devices menu item.
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UPStart automatically discover all of the devices that are on pour specified network as each device report its unique Unit [T You
see this happen as each discovered device reports as NEW or FOUMD. Optionally you can have UPStart add all MEW
devices to the network design file
[ After discovery attempt to add devices to the network design
~ Legend
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tet-2e0 [0 D000 OO0 00 JO000 e
=n-zz [ 00 OO0 0 Q0000 OOOon P Loased
2zt-za 00 DO000 D000 OO P Fobiem
20 )] O ICI]

Close |

The Discover Dialog presents a colored box that represents each possible
device in your selected network. There is a box for each of 250 possible
Unit IDs. A checkbox is provided to allow you the option to add newly
discovered devices to the network. In this example we will leave the
checkbox unchecked.

Step 2: Start The Device Discovery

Press the “Start” button to begin the device discovery. UPStart will change
the color of the box for each device based on whether it was found or not.
A green square means that the expected device was found. A black square
means that the expected device is missing. A yellow square means that an
unexpected (new) device was found on the network.
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UPStart automatically discover all of the devices that are on pour specified network as each device report its unique Unit [T You
see this happen as each discovered device reports as NEW or FOUMD. Optionally you can have UPStart add all NEW
devices to the network design file
[~ after discovery atterpt to add devices to the network design
~ Legend
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Cloze |

Recreating A File From The Device Memory

You can use the device discovery operation to create a whole new file based
on the configuration information in your devices. To do this, follow the
steps below:

Note: in order to successfully add discovered devices to a network the
devices are assumed to be previously assigned the same Network
Parameters (i.e. Network 1D, Network Name, and Network Password) as
specified in the Network Properties Dialog.

Step 1: Specify The Network Properties

Make sure that the Network Properties are set for the network that you want
to discover devices on. You can either start a new network using the
File=>New menu item or you can change the Network Parameters using the
Network—>Properties menu item (refer to Chapter 3 — “Editing Your
Network Parameters”).

Step 2: Bring-Up The Discover Dialog

The Discover Dialog can be activated by selecting the Network-> Discover
Devices menu item.

The UPStart User’s Guide 57



Chapter 10—UPStart Utilities
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The Discover Dialog presents a colored box that represents each possible
device in your selected network. There is a box for each of 250 possible
Unit IDs. A checkbox is provided to allow you the option to add newly
discovered devices to the network. In this case we will check the checkbox.

Step 3: Start The Device Discovery/Add

Press the “Start” button to begin the device discovery. UPStart will change
the color of the box for each device based on whether it was found or not.
A green square means that the expected device was found. A black square
means that the expected device is missing. A yellow square means that an
unexpected (new) device was found on the network.
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ez to the network design file
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In the case where new devices are discovered UPStart will begin
automatically reading their configuration memory and adding them to the
network database. An icon will be added to the main screen for each new
device that has been added to the design. When the discovery/add is
complete press the button to close the dialog.

Viewing A Device

At some point in time you might want to view the contents of a device’s
configuration memory. This can be for any of a number of reasons:

You might have an unknown device that you want to know what’s
inside it (product type, serial number, firmware version, etc.), or

You might want to add a new device but first you want to know if you
want to retain its configuration information or not, or

You might have an existing device but you want to see if the
homeowner has changed anything since you last configured it.

UPStart will allow you to view devices that are both part of your network as
well as those that are not in your network. This chapter will tell you how to
use UPStart do both actions.
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Viewing A Device That Is In Your Network

To view a device that is already part of your network database, simply
follow the steps below.

Step 1: Select The Device To Be Viewed

Using your mouse click on and select the icon of the device to be viewed.
Then start the Viewing operation by right clicking on that icon and selecting
the View pop-up menu item. Alternately, you can start the Viewing
operation by selecting the Device> View menu item. UPStart will perform
the command steps necessary to read your device’s configuration memory.

Operation | Retry | Data | B
\/ Fiead network. name ak.

J Read room name ak

\/ Fiead device name QK.

J Read configuration 1 QK.

J Read configuration 2 QK

J Fead configuration 3 ak.

\/ Fiead configuration 4 ak.

\/ Fiead configuration 5 QK.

J Fiead configuration & QK.

J Read configuration 7 QK.

J Read configuration 8 ak.

Thiz operation completed successfully. Press QK to continue

Details | Ty again

Step 2: View The Device

When the command steps are complete press the OK button to bring up the
View Device Dialog for your device. View Device Dialog is a multi-tabbed
dialog that allows you to view the contents of your device’s configuration
memory. Navigate through this dialog to obtain the information you are
interested in. When you are done press the OK or Cancel button to close
the dialog.
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Viewing A Device That Is Not Part Of Your Network

To view a device that is not part of your network database, simply follow
the steps below.

Step 1: Begin A New View
To begin a New View operation first make sure no icons are selected and

then select the Device->View menu item. UPStart will ask you to put your

device into the Setup Mode.
Step 2: Put The Device To Be Viewed Into Setup Mode

In order to view a device that is not in the UPB Network, UPStart must first
be able to find that device and communicate with it over the powerline. To

do this, UPStart will search for a single device that is in Setup Mode.

Find Device
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Each UPB device has a method for putting it into the Setup Mode. If you
don’t know how to put your device into Setup Mode press the Help button
for instructions or consult the documentation for your device type.

After the device is in the Setup Mode press the OK button to begin the
Viewing operation. UPStart will perform the command steps necessary to
read your device’s configuration memory.

Step 3: View The Device

When the command steps are complete press the OK button to bring up the
View Device Dialog for your device. View Device Dialog is a multi-tabbed
dialog that allows you to view the contents of your device’s configuration
memory. Navigate through this dialog to obtain the information you are
interested in. When you are done press the OK or Cancel button to close
the dialog.

View Device: Unit 001 - Den - Lights
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Replacing A Device

At some point in time you might want to replace a device in your house and
still retain the old device’s configuration information. This can be for any
of a number of reasons:

e You might want to replace an old version of a device with a newer
version of one, or

e You might want to replace one color of device with another color, or

e You might want to replace a defective device (highly unlikely!!!) with
a working device.

In any event, you will want to take out your old device and install the
replacement device. Then you will want to program the replacement device
with the exact same configuration information that your old device had.
This chapter tells you how to use UPStart to do this.

Replace The Physical Device

The first step in replacing a device is to take out the old device and install
the new device in its place. Follow the steps and precautions in the device’s
installation manual to install and test your new device. Make sure that
power is applied to your new device before proceeding to the next step.

Replacing The Configuration Information

Now you can replace the new device’s configuration information with the
exact same configuration information that was stored in your old device.
To do this, simply follow the steps below.

Step 1: Select The Old Device

Use your mouse to click on and select the icon of the old device to be
replaced. Then start the Replace operation by right clicking on that icon
and selecting the Install/Replace pop-up menu item. Alternately, you can
start the Replace operation by selecting the Device—> Install/Replace menu
item.
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Step 2: Put The New Device In Setup Mode

UPStart will now instruct you to put the new device into Setup Mode.

Install # Replace Device x|

Urit 001 - Den - Lights

The Install or Replace operation is useful when you want to replace an old or
defective device with new hardware. Regardless of the memorny contents

of the device, it iz replaced by the configuration info from this file. The device
mizt be connected to the powerling and powered on.

To begin, pleaze put the new device ta be programmed into SETUP mode.
|UPStart then finds that device. If you don't know how to put the device into

SETUP mode, press the Help button.

Press OF to cloze thiz dialog when the device iz in SETUP mode.

Caticel | Help |

In order to replace a device to the UPB Network, UPStart must first be able
to find that device and communicate with it over the powerline. To do this,
UPStart will search for a single device that is in Setup Mode. Each UPB
device has a manual method for putting it into the Setup Mode. If you don’t
know how to put your device into Setup Mode press the Help button for
instructions or consult the documentation for your device type.

Note: devices will automatically time-out of the Setup Mode after five (5)
minutes. Make sure that you don’t wait too long to press the Next button
after you have put your device in Setup Mode or you may have to repeat
some of the steps.

Step 3: Replace The Configuration Information

After the device is in the Setup Mode press the OK button to begin the
Replace operation. UPStart will begin performing the command steps
necessary to find and write your device’s memory.

64 The UPStart User's Guide



Chapter 10—UPStart Utilities

Command Steps
Operation | Fietry | Data | =
J Wwiite configuration 4 01 06 08 06 OF 01 05 07 OF OF B4 FF 64 00 00 FF
J ety canfiguration 4 01 06 08 06 OF 01 05 OF OF OF 64 FF 64 00 00 FF
J Wwirite configuration 5 0000 FF FF FF FF FF FF FF FF FF 84 FF 84 84 FF
J Werify configuration 5 00 00FF FF FF FF FF FF FF FF FF 84 FF 84 84 FF
J wiite configuration 6 2200FF 22 B4 FF 2300 FF 23 B4 FF 24 FF FF 21
J Wity configuration & 2200FF 22 B4 FF 2300 FF 23 B4 FF 24 FF FF 21
J Wiite configuration 7 FFFF20FF FF 220000 22 64 00 22 00 01 22 64
J Veiity configuration 7 FFFF20FF FF 220000 22 64 00 22 00 01 22 64
J Wiite configuration & 0122000822 64 08 25 1E FF FF FF FF FF FF FF
J Veiity configuration & 0122000822 64 08 25 1E FF FF FF FF FF FF FF
J Exit setup mode aK
Thiz operation completed successfully. Press 0K to continue.

Dretails |

Try again |

If UPStart fails one of these command steps it will place a red “X” next to
the failed step and it will stop and instruct you as to what to do next. If
UPStart successfully completes all of its command steps it will place a blue
checkmark next to each step and display a message that the operation
completed successfully. Press the OK button to close the command steps
dialog.

Note: by default, the command steps dialog will stop and wait for you to
press the OK button before going on to the next step of the wizard. If you
would rather not be bothered with this each time the command steps are
done then you may configure UPStart to not require the OK button press.

Refer to Chapter 12 — “Customizing UPStart Behaviors” to learn about
changing the UPStart options.
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Reading Devices Into The Network Database

At some point in time you might want to overwrite the contents of the
network database with the information read from a device’s configuration
memory. This can be for any of a number of reasons:

e You might want to capture homeowner changes into your file, or

e You might have made an unwanted change to your file and want to
restore it back to what the device is programmed to.

UPStart will allow you to read the configuration memory of one (or all)
device(s) into the network database. This chapter will tell you how to use
UPStart to do this with both a single device and with all of your devices.

Reading A Single Device Into The File

If you want to read the device configuration information for a single device
then follow the steps below.

Step 1: Open Up The Edit Device Dialog

The Edit Device Dialog can be opened up in several different ways; either
double-click on a device’s icon, or right-click on a device’s icon and select
the “Edit" pop-up menu item, or select a device’s icon and then pick the
Device->Edit menu item.

Step 2: Read The Warning Message

If the device has not been verified to match the file then UPStart will warn
you of that fact with the following message. If you don’t get this message
then skip to the next step.

& Are yau sure?

A change was made to the configuration settings for this dewvice. saved in
the network file, but notyet written o the mermory of the device. [fyou
continue this operation you may be overwriting changes thatwere macde
tothe device mermory at a previous time and not seved in the network file

To see howthe device memary differs fram the network file configuration
settings, select from the menu: Network then Yerify, or selectthe device,

right click. and choose Verify from the popup menu
Toignore what is in the device memory and to update it to what is
specified in the network file, selectthe dewice, right click, and choose

Frogram from the popup menu

Continue this operation even though the device has not heen verified?

—— Feear
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Read the message and then press the “Yes. Go ahead” button.

Step 3: Read The Device's Memory Into The File

After making sure that you want to overwrite the file’s contents with the
configuration information that is stored in the device memory press the
“Read” button on the Edit Device Dialog. UPStart will perform the
command steps necessary to read the contents of your device’s
configuration memory and write it into the file copy.

Command Steps
Operation | Fietry | Data | -l
J Fead senal number ooa0oooaon
W Check UPE version 01
J Check device type [51)wWall Switch - 1 Channel
J Fead configuration 1 u]

J Read configuration 2 u]

J Fead configuration 3 u]

J Fead configuration 4 ar

J Read configuration 5 u]

J Fead configuration & u]

J Read configuration 7 u]

J Read configuration 8 u] S |
This operation completed successfully. Presz OK to continue.

Details |

When the command steps complete, press the OK button to close out the
dialog. UPStart will display the following message to inform you that the
file’s configuration information has been changed.

Tiy again |

UPStart x|

@ It may be helpful to know..

The dewice configuration just read from the dewvice is notthe same as the
configuration in the design datahase. The design datahase and some of
the properies you may see on the screen have been updated to reflect
thig new information

lunderstand

After you have read the message press the “I understand” button to close it.
Then press the OK button to close the Edit Device Dialog.
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Reading All Devices Into The File

If you want to read the device configuration information for all of your
devices then follow the steps below. All of your devices will be read and
the contents of their configuration memory will be written to the network
database file.

Step 1: Start The Read All Operation

Start the Read All operation by selecting the Network->Read All menu
item. UPStart will warn you that your network database file will be
overwritten with the contents of your devices’ configuration memory.

UPStart

@ Are you sure?

The Fead All operation does this: For each of yvour dewvices, UFStart takes
all the configuration settings from the device memaory and sawves them in
this file. This makes sure that the device configuration sawved here exactly
matches the device memary. This also means that amything in this file

that differs frorn what is specified in the dewvice is owverwritten.

Are you sure you wantto do this?

vesg. Go ghead Mo, Don'tdo

Step 2: Continue The Read All Operation

Press the “Yes. Go ahead” button to continue the Read All operation.
UPStart will now bring up the Multi-Device Operation Dialog and begin
reading all of your devices’ configuration memory. This may take a while
to complete so be patient.
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Operation | Retry | Data | B
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\f Fead configuration & 0K
\/ Fiead configuration B 0K
J Read configuration 7 Ok
\/ Fiead configuration & 0K
J Walidate configuration 0K J

The dialog has a colored square for each of 250 possible Unit IDs for your
network. The squares that correspond to your devices will start out colored
yellow. As each device is read, UPStart will change the square a different
color based on the results of the read operation. If the read was successful
the square will be changed to blue. If the read was unsuccessful the square
will be changed to red.

Step 3: Finish The Read All Operation

When the Read All operation is complete, press the OK button to close the
Multi-Device Operation Dialog. Assuming all went well, all of the device
icons should now have a blue bar underneath them indicating that the file
copy matches the devices’ configuration information.
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UPB Reception Logging

UPStart can log UPB communications that occur on your powerline so that
you can see what has been happening on your powerline over a period of
time. The UPB reception log can be written to a file and UPStart can
display it.

Setting Up UPB Reception Logging

70

UPB Reception Logging can be enabled and set up using the UPStart
Options dialog. This dialog is activated by selecting the Tools=>Options
menu item. This dialog has a special Log tab for configuring the UPB
Reception Logging.

Dptions

UPStart Operation  Leg | Advanced I

— Does UPStart log?

IV Enable UPE reception lnaging. Eveny reception, the date, time, message. and its effects are logged:

—Where are the log files stored and how rany entries are kept?

There are two log files maintained by UPStart. The entries in the current log file can be viewed by the UPStart
bwilt-ins log wigwer. The historical log file iz uzed to gather data over time and can be loaded into databaze ar
spreadshest programs.

Each time UPStart iz started, it can move the contents of your current lag file intra the histarical log file. Ta make
sure that the historical log files doesn't get too big, you can limit its size. |f you don't need to maintain a historical
log file, just leave the path for it blank.

Current log file IE:\Program Filez4PCS Lighting'Logs4UPELog.log Browse |

Hizstorical log file I Browse |
Fietain |1DDD _I;' histarical log entries.

-~ Option
Each meszage reception iz logged and can either show all of the affected receivers - if multiple receivers
exist - or just the reception can be logged.

™ Show all meszage recipients in the log

()8 I Cancel

Enabling UPB Reception Logging

UPStart can log UPB communications that occur on your powerline so that
you can see what has been happening over a period of time.

By enabling this option, UPStart will log UPB communications that occur
on your powerline into the specified log files.
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Specifying The Log Files

There are two log files maintained by UPStart. The entries in the Current
Log can be viewed by the UPStart built-in Log Viewer. The historical log
file is used to gather communication data over time and can be loaded into
database or spreadsheet programs for viewing and analysis.

Each time UPStart is started it can move the contents of your current log
file into the historical log file. To make sure that the historical log file
doesn’t get too big, you can limit its size. If you don’t need to maintain a
historical log file just leave the path for it blank.

Logging All Affected Receivers

Each message reception is logged and can either display a line for each
affected receiver or just the reception can be logged.

By enabling this option, UPStart will log each affected receiver on a
separate line of the log file. This will give more information but it could
also fill up the log file quicker.

Viewing UPB Reception Logging

The current UPB Reception log file can be viewed with the Log Viewer.
This viewer is activated by selecting the Tools=>Open Log Viewer menu

Item.

Enty [ Date = [Fevd [Met [Cmd [ Souce [ Mame ] Comparent [Dest [ Mame =
Recwe  5/11/04 6:31:56 PM 14 123 Goto Unit 007 Urit 007 - Master Bedoom - L. Top Rocker Link 005 Urit 010 - Master Bedr.
Recwe  5/11/04 6:31:56 PM 14 123 Goto Unit 007 Urit 007 - Master Bedoom - L. Battom Rocker Link 005 Urit 010 - Master Bedr.
Recwe  5/11/04 6:32:00 PH 14 123 Goto Unit 007 Urit 007 - Master Bedoom - L. Top Rocker Link 005 Urit 010 - Master Bedr.
Recwe  5/11/04 6:32:00 PH 14 123 Goto Unit 007 Urit 007 - Master Bedoom - L. Battom Rocker Link 005 Urit 010 - Master Bedr.
Reowe  5/11/04 6:32:05 PM 14 123 Activate Unit 001 Urit 001 - Front Hall - Controller— Button OFF Link 003 [multiple receivers]
Reowe  59/11/04 63209 PM 14 123 Goto Unit 005 Unit 005 - Qutside - Lights Top Rocker Link 004 Unit 010 - Master Bedr..
Rove SA1/D463209PM 141 123 Golo Unit 005 Uit 005 - Dutside - Lights BottomRacker  Link 004 Urit 010 - Master Bedk..
Rove SA1/D463212PM 141 123 Golo Urit 004 Uit 004 - Kitchen - Lights Top Rocker Link 003 Urit 010 - Master Bedk..
Rove SA1/0463212PM 141 123 Golo Urit 004 Uit 004 - Kitchen - Lights BottomRacker Lk 003 Urit 010 - Master Bedk..
Rove SA1/D463214PM 172 123 Golo Unit 003 Unit 003 - Kitchen - Appliances  Top Racker Link 002 Urit 010 - Master Bedk..
Rove SA1/D463214PM 22 123 Golo Uit 003 Unit 003 - Kitchen - Appliances  Bottom Rocker  Link 002 Urit 010 - Master Bedk.
Reowe  5/11/04 B:32:16 PM 142 123 Goto Unit 003 Urit 003 - Kitchen - Appliances  Top Rocker Link 002 Urit 010 - Master Bedr.
Reowe  5/11/04 B:32:16 PM 272 123 Goto Unit 003 Urit 003 - Kitchen - Appliances  Bottam Rocker Link 002 Urit 010 - Master Bedr.
Reowe  5/11/04 B:32:18 PM 14 123 Goto Unit 004 Urit 004 - Kitchen - Lights Top Rocker Link 003 Urit 010 - Master Bedr.
Reowe  5/11/04 B:32:18 PM 14 123 Goto Unit 004 Urit 004 - Kitchen - Lights Battom Rocker Link 003 Urit 010 - Master Bedr.
Reowe  5/11/04 6:32:20 PM 14 123 Goto Unit 005 Urit 005 - Outside - Lights Top Rocker Link 004 Urit 010 - Master Bedr.
Reowe  5/11/04 6:32:20 PM 14 123 Goto Unit 005 Urit 005 - Qutside - Lights Bottom Raocker Link 004 Urit 010 - Master Bedr..
Rove 5A1/0463223PM 141 123 Acivale  Unt006  Unit0DS-Back Hall- Contoller  Bution C Link 012 [muliple receivers]
Rove 5/1/0463229PM 141 123 FadeStat  Unt006  Unit0D5-Back Hall- Controller  Bution C Link 012 Urit 001 - Frort Hall - €.
Rove 5/1/0463233PM 141 123 FadeStop  Unt006  Unit0D5-Back Hall- Controller  Bution C Link 012
Rove 5A1/0463236PM 141 123 FadeStat  Unt006  Unit0D5-Back Hall- Controller  Bution C Link 012 Urit 001 - Frort Hall - €.
Rove 5A1/0463237PM 141 123 FadeStop  Unt006  Unit0D5-Back Hall- Controller  Bution C Link 012
Reove 511704 :32:43PM 14 123 Activate Unit 001 Urit 001 - Front Hall - Controller— Button ON Link 008 [multiple receivers]
Reowe  5/11/04 6:32:46 PM 14 123 Goto Unit 002 Urit 002 - Den - Lights Top Rocker Link 001 Urit 010 - Master Bedr.
Reowe  5/11/04 6:32:46 PM 14 123 Goto Unit 002 Urit 002 - Den - Lights Battom Rocker Link 001 Urit 010 - Master Bedr.
Reowe  5/11/04 B:32:52 PM 14 123 Goto Unit 009 Urit 003 - Entertainment - Lig. Top Rocker Link 007 Urit 010 - Master Bedr.
Reowe  5/11/04 B:32:52 PM 14 123 Goto Unit 009 Urit 003 - Entertainment - Lig. Battom Rocker Link 007 Urit 010 - Master Bedr.
Reowe  5/11/04 B:32:55 PM 14 123 Activate Unit 001 Urit 001 - Front Hall - Controller— Button OFF Link 003 [multiple receivers]

| | 2

A
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Copying The Reception Log

Each time UPStart is started it can move the contents of your current log
file into the historical log file. You can also command UPStart to move the
contents of your current log file into the historical log file. Clicking on the

upper left-hand corner of the UPStart Log Viewer and selecting the Copy
item will do this.

Clearing The Reception Log

72

The contents of the UPB Reception log file can be cleared. Clicking on the
upper left-hand corner of the UPStart Log Viewer and selecting the Clear

item will do this. UPStart will ask you to first verify that you truly want to
clear the log.

UPStart x|

@ Are you sure?

Clearing the log is an irreversible action. All entries in the log will be lost.
Are yiou sure you want to clear the log?

Yes. Go ahead . No.Don'tdoit
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Using UPStart In The Offline Mode

UPStart can be operated without a powerline interface in a mode of
operation known as the Offline Mode. In the Offline Mode you can still
perform most of the normal UPStart operations except for programming
your devices of course. This chapter will explain the differences between
using UPStart in the Offline Mode and the Online Mode. It will also
explain how to change back and forth from the Online Mode to the Offline
Mode.

Why Use The Offline Mode?

The Offline Mode is used to design and edit networks while you are not
connected to a powerline interface. You might choose to use the Offline
Mode of any of the following reasons:

e You want to design a network for your home while at the office and
then program it into your home later.

e Youdon’t currently have a working powerline interface device but you
still want to work on your network design.

e You want to add devices to your network design before you have
installed them into your home.

e Your powerline is too noisy for good communication. You still want to
work on the network design while you are troubleshooting the noise
problem.

Changing To The Offline Mode

If UPStart detects that your powerline interface module is missing it will
automatically switch you to the Offline Mode. If you ever want to switch
from the Online Mode to the Offline Mode you can do it using the UPB
Interface Setup Dialog. Bring up the UPB Interface Setup Dialog by
selecting the Tools>UPB Interface menu item.
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UPB Interface Setup

None
None

Powerling Interface Maodule [FIM]
USE Powerline [nterface Module [PIM

Change the Interface selector to “None” and press the OK button to switch
to the Offline Mode. UPStart will indicate that you are now in the Offline
Mode with a special offline indicator in the lower right of the status bar.

online/offline indicator
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Things You Can’t Do in the Offline Mode

While in the Offline Mode, UPStart will not allow you to do the following
operations:

e Program Devices

o Install/Replace Devices

e Read Devices

e View Devices

o Discover Devices

e Functionally Test Devices

e Device Communication Test
e Network Communication Test
e Network Verification

e Log Viewer

Also, while in Offline Mode, none of the signal and noise meters that
UPStart provides will be operational.

Things You Can Do in the Offline Mode

While in the Offline Mode, UPStart will allow you to do the following
operations to the network database:

e Create A Network
e Add Devices
e Delete Devices

e Edit Devices

All modifications will be saved up in the network database and can be
programmed into the devices once you are back in the Online Mode (refer
to Chapter 7 — “Programming Your Devices” for instructions on
programming your UPB devices.
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Customizing UPStart Behaviors

Everyone who uses UPStart is an individual and is subject to individual
tastes and desires. One feature of UPStart might be extremely desirable to
one user while it is extremely annoying to another. UPStart gives you a set
of features that can be customized to your individual liking using the
UPStart Options dialog available by selecting Tools=>Options.

UPStart Operation Options

The UPStart Operations tab (see figure below) allows you to customize how
UPStart performs its normal operations. The various UPStart options for
this tab are described below.

The UPStart User’s Guide 76



Chapter 12— Customizing UPStart Behaviors

Auto Close Popup On Success

When UPStart performs a series of command steps it will display a
command steps popup that lists all of the operations performed and the
results thereof. When all of the command steps are completed successfully,
UPStart will stop and wait for you to press the OK button before it closes
the popup. This can become annoying to some operators.

By enabling this option UPStart will automatically close the command steps
popup whenever the list of commands completes without error.

Auto Save On Device Write

Each time UPStart writes to a device’s memory it will write the most recent
set of changes that have been specified. These changes may not be stored in
the design file.

By enabling this option, UPStart will write the latest configuration
information into the design file each time that it writes this information to
the device. This helps ensure that your file matches your hardware.

Auto Export On File Save

The network database can be exported to a file for importing to home
automation controllers. This export can be done manually or automatically.

By enabling this option, UPStart will automatically export the network
database to the export file each time it writes to the design file. The export
is written to the same file used for the last export, so this option will not
take effect until after the first manual export.

Reopen Last File Loaded When UPStart Begins

When UPStart begins it can automatically reopen the last network file you
had open. This can be desirable if you tend to work on the same network
file over and over again.

By enabling this option, UPStart will automatically reopen the last network
file you had open whenever it begins.

Automatic Network Verification Upon File Reopen

When UPStart reopens a network file it can automatically attempt a network
verification. This can be nice to give you confidence that what you have in
your file is what you have in your devices. This can also become annoying
to some operators.

By enabling this option, UPStart will automatically attempt a network
verification whenever it reopens a network database file.
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Display Unit IDs

When UPStart displays dialog titles and device icons it inserts the device’s
Room Name and Device Name. It can also display its Unit ID. This can
make it easier for some operators to keep track of devices. This can also
become annoying to other operators.

By enabling this option, UPStart will display the Unit ID in dialog titles and
device icon labels.

Number Of Retries

Whenever an UPStart operation fails it can be retried from anywhere from 1
to 16 times before giving up. This option allows you to set the number of
retries to whichever value (1 — 16) that you desire.

UPStart Logging Options

78

UPStart can log UPB communications that occur on your powerline so that
you can see what has been happening over a period of time (see Chapter 10
— “UPB Reception Logging™). The UPStart Log tab (see figure below)
allows you to customize how UPStart performs its logging operations. The
various logging options for this tab are described below.
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Options E3

UPStart Operation  Leg | Advanced I

— Does UPStart log?

¥ Enable UPE reception logging. Every reception, the date, time, message, and its effects are logged.

—where are the log files stored and how many entries are kept?

There are two log files maintained by UPStart. The entries in the current log file can be viewed by the UPStart
built-in log viewer. The historical log file iz uzed ta gather data over time and can be loaded into databaze ar
spreadsheet programs.

Each time UPStart iz started, it can mowve the contents of wour current log file intro the histarical log file. To make
sure that the: historical log files dogsn't get too big, you can limit its size. |f you don't need to maintain a historical
log file, just leave the path for it blank.

Current log file IE:\Program Filez4PCS Lighting'Logs4UPELog.log Browse |

Hizstorical log file I Browse |
Retain |1DDD _I;' historical lag entries.

— Option
Each meszage reception iz logged and can either show all of the affected receivers - if multiple receivers
ezt - o just the reception can be logged.

™ Show all meszage recipients in the log

()8 I Cancel

Enabling UPB Reception Logging

UPStart can log UPB communications that occur on your powerline so that
you can see what has been happening over a period of time.

By enabling this option, UPStart will log UPB communications that occur
on your powerline into the specified log files.

Specifying The Log Files

There are two log files maintained by UPStart. The entries in the Current
Log can be viewed by the UPStart built-in log viewer (see Chapter 10 —
“UPB Reception Logging™). The historical log file is used to gather
communication data over time and can be loaded into database or
spreadsheet programs for viewing and analysis.

Each time UPStart is started it can move the contents of your current log
file into the historical log file. To make sure that the historical log file
doesn’t get too big, you can limit its size. If you don’t need to maintain a
historical log file just leave the path for it blank.
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Logging All Affected Receivers

Each message reception is logged and can either display a line for each
affected receiver or just the reception can be logged.

By enabling this option, UPStart will log each affected receiver on a
separate line of the log file. This will give more information but it could
also fill up the log file quicker.

UPStart Advanced Options

UPStart has other options that might be desired to be enabled by some
advanced operators. The UPStart Advanced tab (see figure below) allows
you to customize how UPStart performs its advanced operations. The
various advanced options for this tab are described below.
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Logging The Network Communications Test

During A Network Communications Test (refer to Chapter 8), UPStart can
create a log file showing all of the UPB messages sent and received. This
may be useful for technical support resolving problems with UPB
communications.

By enabling this option, UPStart will create a log file showing all of the
UPB messages sent and received during the Network Communications Test.

Providing Support For The Commercial Router Repeater

UPStart can provide support for a number of powerline interfaces. Some of
these are only used in commercial applications and not needed for
residential applications.

By enabling this option, UPStart will provide support for the Commercial
Router Repeater (CRR) three-phase powerline interface.
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Chapter 13
Getting Help

The UPStart setup tool can be a complex program. As you use UPStart,
you may find that you have questions about how to do some things, or you
may find an area where UPStart doesn’t behave as you expect.

Outlined below are some procedures and resources available to help resolve
problems if you find yourself in a situation where you think you need help.

Before you look too far for answers, make sure that you don’t already have
the information you are looking for. Check the User Guide carefully for the
feature with which you are having problems. Make sure that you are
following the directions completely and carefully.

Our web site

If you are still having problems, the next place to look is the PCS Technical
Support web site that contains extensive resources for UPStart. The web
site is located at:

http://www.pcslighting.com
Some of the information available on the web site includes:

o Alist of frequently asked questions. Your questions may already be
answered there.

e Technical Notes on some areas that are not covered fully in the User
Guide.

e Links to the web sites for manufacturers of those UPB devices that
UPStart works with.

If none of the Internet resources helps you fully resolve your problem, the
PCS technical support staff will work closely with you to solve any
problems related to our software.
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Other considerations

While our support personnel will do their best to help you with your
software related problems, we know that on occasion a problem can be
traced to hardware or to another software application. We will supply as
much help as we can, but we can’t provide support for products
manufactured or published by another company. If you are having
problems with your video display or printer, please make sure that you have
the most current drivers for them. These can usually be found by contacting
your computer manufacturer directly.

Finally, this product is designed to be used on PCs configured with the
current versions of Microsoft Windows. This means that we tested for
those configurations, and not every operating environment that you might
encounter. Any non-standard hardware or software you have may be at the
root of your problem. If possible, please disable all such devices to be sure
that they are not causing your problem.

Technical support

84

Unlike other companies you may have worked with, PCS provides technical
support that is available using e-mail. You might find that e-mail is a more
satisfying way to get technical support. You won’t be put on hold, and the
technician will have time to fully consider your problems and formulate an
answer.

Technical support can be reached either from the bug reporting form on the
support web site, or directly by sending e-mail to:
Support@PCSLighting.com

To receive the fastest response to your technical questions, please include
the responses to ALL of the following items in your e-mail.:

o What is the exact sequence of events that created the problem? Make
sure that you can reproduce the problem by following the same series
of steps.

e What is the version number of UPStart? To get the version number
from the Help menu, choose About UPStart.

e What is the type of computer you are using and the version of Windows
in use? The operating system version number can be found using the
control panel System applet.

e  Provide the exact wording of any error messages.
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Software is very complex and a program like UPStart is a very complex
program. While the programmers try extra hard to get it right, sometime
problems happen. If you find a problem please report it in a way that helps
us find it and fix it.

Reporting a bug is an art that everyone should learn regardless of what
software you are working with. It is vital that you provide all the
information you can. The absolutely most important thing you can do is to
tell us how to reproduce the bug. Sometimes this is easy. "Open my design
file, select the device called Bathroom Lights select the Edit Device
operation and UPStart dies".

Now sometimes you can't reproduce the problem. So give us suggestions.
For example, if you have a problem where occasionally UPStart crashes try
and determine what might have been happening at that time. Were you
working with the user interface? Was UPStart just sitting there? Do you
think that it died when some controller pushbutton got pressed? Guess.
Theorize. Be a detective. Try and reproduce the problem yourself. Give us
all the information you have: "UPStart dies sometimes at night. | think it
has to do with my bathroom light being on. Attached is my UPStart file".

The more information you provide the quicker the problem can be identified
and fixed.

Hardworking programmers everywhere thank good bug reporters.
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